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Introduction

Thank you for choosing a Melbourne IT WebWorks solution for your website management. As you use your

Melbourne IT WebWorks solution you will discover just how easy we have made it to manage a simple website.

A Melbourne IT WebWorks solution provides you with your own domain name (or URL) for your website, up to

5 e-mail addresses at that domain, simple webpage editing (similar to using a word processor), image control

for easy uploading of images to insert on your pages, a simple feedback form, online help, visitor statistics and

over 40 different template designs to choose from.

Quick Overview

The Melbourne IT WebWorks interface uses a simple tab based navigation system to help you move through

the software and perform your required task as quickly and easily as possible. Let’s take a look around and

examine its layout and functions.

Home

Every time you log-in to your Melbourne IT WebWorks interface, you will be directed to the Home

section. The Home section provides you with one click access to some of the most commonly used

functions.    You can also move around your Melbourne IT WebWorks interface by clicking on the tabs

at the top of the screen or by selecting the options from the menu on the left of the screen. 
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Build

The Build section of the Melbourne IT WebWorks interface is where you create and edit your website.
The build section has two main functions.

Web Page Editor

The Web Page Editor is where you add, delete and

edit the content on your pages.  You simply select the

page you wish to edit from your list of pages and use

the Web Page Editor to change your content. You can

copy and paste content from a word processor

document such as Microsoft Word 97 or type the

text in directly (if using Office 2000 please see page 7). The Web Page Editor enables you to

format your text and images in a similar way to a word processor. 

Image Manager

The Image Manager is used to transfer images and graphics from your own computer to your

website.  Each file must be a .jpg or .gif file and must be less than 100kb. It is important that

you do not put too many images on a page (we generally recommend no more than three) and

that you keep the file size of the images as small as possible (we recommend below 30kb).  Lots

of large images on a page will make it slow to download.  When you have transferred the

images, you can include them in any or all of your web pages using the “Insert Image” function

in the Web Page Editor. 

File Manager

The File Manager is used to transfers PDFs to your website. When you have transferred the files

you can include them in any or all of your web pages by using the “Hyperlink” function in the

Web Page Editor. Each file must be less than 500KB but we recommend you keep sizes to a

minimum to ensure that file download times for your website visitors are not too long.

Publish

Anytime you make changes to your website you need to Publish them before they are visible to the

public. All the publishing functions are managed in the Publish section of Melbourne IT WebWorks

interface. 

Before publishing your website, you can preview it in full by clicking on the Preview Website button. A

new window will open, showing your website with all your latest changes. If you are happy that the

content is correct, you can publish it by clicking on the Publish Website button. You will receive a

confirmation that all your pages were published successfully. 

Admin

The Administration section of Melbourne IT WebWorks interface contains several functions that look

after the day to day management of your website. 
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Company Information

You can update your company information such as your address and contact details and your

Company name and slogan. This information is used to identify your Company to your visitors

and to keep you in touch with the latest updates and changes we make to the Melbourne IT

WebWorks interface. 

Website Style

You can change the style of your website at any time by selecting a new style template and

colour scheme from the style library. Our library includes over 40 styles and colours to choose

from. If you do select a new style and colour scheme for your website, you will have to Publish

your website so the change is visible. 

Company Logo

Your Company logo appears on your web pages. If your logo changes you can transfer a new

one from your computer to your website. 

Menu Manager

Your Menu Manager determines which pages appear on your website by

creating your website navigation. To change the name of any of the pages

on your website or to add or remove pages, you can select the pages using

the Menu Manager function. 

Edit User Details

You can edit the password and contact e-mail addresses for any of your registered users. 

Promote

Website Statistics

Once your page is Published on the Internet you can check your statistics to see how often your

website is being viewed, amongst many other functions available through this feature.
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E-mail

A Melbourne IT WebWorks solution allows you to have up 5 separate e-mail accounts/addresses so

you can provide your employees with their own e-mail address. Setting up the accounts is a very simple

process. All you need to do is provide a new e-mail Username and select a Password for the new

account. The e-mail account is then automatically set up. Deleting accounts is just as simple; just click

the Delete button.

Help

If you need help at any time, you can access this manual and help files from the help section of the

Melbourne IT WebWorks interface. 

Adding and Deleting pages on your Website

The number of pages on your website and the order they

appear in the menu is controlled through the Menu Manager

on the Admin tab. The Menu Manager allows you to add and

delete pages, change the name of pages and set the order of

pages on your website navigation menu.

The Menu Manager displays a Menu Button List and Sample

Buttons. To add a page to your website you can either :

1. Type the title of the page directly into the menu button

list or,

2. Select a title from the Sample Buttons list and click the arrow button next to the field in the Menu Button

List.

To delete a page on your website simply remove it from the Menu Button List by highlighting the page title and

pressing the delete button on your keyboard.

Once completed adding and deleting pages on your website, click on the Save button at the bottom of the

page.
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Editing and Adding Content to Your Website Pages

To Edit the content in your website pages go to the Web Page Editor.  Click the Edit button next to the page

you wish to change. The Web Page Editor will open.

To add text, you can either type directly into the Page Editor or copy and paste text directly from Microsoft

Word 97.

Pasting Content from MS Office

Moving between MS Office and the Melbourne IT WebWorks interface is easy.  Use the Windows

navigation bar to move between these two programs.

Highlight the text you need within MS Office and use the Cut or Copy function. Toggle back  and Paste

the text in the Web Page Editor.

You will notice that where there was previously single line spacing in a text block, there is now double

line spacing.  This is because HTML language does not recognise carriage returns (see “Tips for

Cutting and Pasting” below for the workaround).  

Only text can be pasted into the Web Page Editor.  Images must be added to your page within

Melbourne IT WebWorks using the Image Manager.

The Web Page Editor will keep the following formatting styles from MS Office applications:

Bold, Underline, Italics, Fonts, Font Sizes, Text Colour, Bullets and Numbering and Tables.  

NB: Once text has been pasted into the Web Page Editor, font sizes scale relatively so they are within

the scale of the 7 font sizes available within HTML.  

Tips for Cutting and Pasting:

You will notice that anywhere you have used the enter key in your word document, you will now have

a double space in the Web Page Editor.  To resolve this you can backspace the double enter and

then hold down your shift key while hitting enter to go down one line.  If you use shift enter in your

original word document you will not have this problem.

MS Office 2000 Users

With the release of Office 2000, Microsoft has made some changes to the way that Word formats text.

This can lead to some formatting inconsistencies that can at times be frustrating. In response to these

changes, we have introduced two functions to the Web Page Editor to re-format the text copied from

Office 2000 applications.

When copy and pasting from an Office 2000 application, paste the text into the Web Page Editor and

then click on the ‘Remove Office 2000 code’ button on the tool bar. If you still experience trouble with
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the formatting of your text or you are unable to make any changes to the formatting, click on the

‘Remove all Styles’ button.

Entering Content Directly into the Web Page Editor

The Web Page Editoris slightly different from most word processing packages because it has to use

HTML, a key Internet language.  

An important point to remember when you are entering and formatting text in the Web Page Editor is

that the text needs to be highlighted BEFORE you change the format (i.e. font, font size, colour or style,

etc.)

Toolbar Functions

• Cut, Copy and Paste Buttons – You can Cut, Copy and Paste within the Web Page Editor and

other computer applications.  

• Bold, Italics and Underline Buttons – Remember to highlight the text before selecting one of these

applications.  

• Hyperlink – You can insert Hyperlinks into your web page.  To insert a hyperlink you must

highlight the text in the Page Content box before clicking on the Hyperlink Button 

Clicking this button will bring up the Insert Hyperlink pop-up box.  Choose from Your Pages,

Other Files and Other Links tabs. 

Your Pages – From the drop down menu you can select any page from your website that you

have already created.  If this is the first page you have created there will be nothing in the list.

Other Files – From the drop down menu you can select any PDFs you have transferred using

the File Manager located under the Build tab. When your website visitor clicks on the link you

have created the file will either open within their browser or prompt to be downloaded,

depending on the browser version that your visitor is using.
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Other Links – You can link to any other Web Page, Secure Website, E-mail Address, FTP File, or

other URL.  Select the Link Type and then type in the full URL in the text bar.

(see advanced features for linking thumbnails)

• Colour Palette – You can choose from 256 colours.  Highlight the text before you select the

colour.  Each Website Style has a default colour.

• Insert Image – An Insert Image pop-up box will appear.  Within the Image Directory Contents

you may have a range of files to choose from.  These files will be images that you uploaded

through the Image Manager (see below). Note: Only .jpg or .gif files can be used in the

Melbourne IT WebWorks interface.

When you have selected an image, a preview of the image will appear on the right side and the

URL is inserted in the URL bar.

In the Alt text field you can insert a caption.  When viewing your website, this caption is viewed by

hovering the mouse over the picture.  Alternatively this field can be left blank.

Uploading new image: The Web Page Editor also has an image upload feature in the Insert

Image pop-up box. To upload a new image from the Insert Image pop-up, click on the Browse…

button at the bottom, select your image and then click Upload. Your list of available images to

insert in the page will then be updated and you can insert the image on the page.

Aligning Image: You can align the image using the drop down box to Default, Left, Right, Top,

Middle, Bottom

Default -  This will set your picture into the text without text wrapping.  You can then use text

alignment to align this picture to the left, centre or right.  But you will not be able to place text

next to the image.

Left and Right Align: This will align the image to the left or right of the surrounding text.  Selecting

either left or right align allows the text to wrap around the image.  

Top, Middle and Bottom Align: This aligns the surrounding text top, middle or bottom to the

image.  
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Border - Your image can have a black border in a range of pixel widths between 1- 5.  The

border will not be viewed in the Image Preview box.  The default is 0, which is no border.

To change the image alignment, border width or image itself, you will need to delete the current

image and reinsert using the Insert Image button.

• Find - Locate text in your page content.

• Undo - Undo the last editing command

• Redo - When you have performed an Undo on you content, you can redo the last editing

command. This is useful if you have clicked on Undo by mistake.

• Left, Centre and Right Align Buttons – NB The Melbourne IT WebWorks interface does not

support justified text.

• Numbered List - Create a numbered list. Each new line will start with the next consecutive

number. To end a numbered list, either press the Enter key twice or click on the Numbered List

button again.

• Bulleted List - Insert a bulleted list. Each new line will start with a bullet and the text will be

indented. To end a bulleted list, either press the Enter key twice or click on the Bulleted List

button again.

• Decrease Indent – Decreases indent and is used to turn bullets or numbers off.

• Increase Indent – Increases indent and can be used in place of the tab key.

• Styles – The Web Page Editor has a number of Styles you can use

• Fonts – Choose between Arial, Times New Roman, Courier New and Verdana, Comic Sans and

Trebuchet MS.  The default font is Arial.  Remember to highlight the text and then change the

font.

• Font Sizes – Font sizes are number 1 to 7, as they are in HTML.  One (1) is the smallest; Seven

(7) is the largest.  The default is 1. Remember to highlight the text and then change the font size.  

• Insert Table - Click on this button to insert a table into your content. Tables are very useful for

formatting and placing text and images on a page. When you click on the Insert Table button, a

pop-up dialogue box will appear. In the dialogue box you can select the properties of the table

you want to insert.

Rows - Insert the number of rows you would like in your table. You can increase and decrease

the number of rows after your table has been inserted.
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Columns - Insert the number of columns you would like in your table. You can increase and

decrease the number of columns after your table has been inserted.

Width - Insert the width of your table. You can select the width as either a percentage of the width

of the screen or as a number of pixels.

Background Colour - Select a colour for the background of your table. If you do not select a

colour or select None, the table's background will be transparent.

Caption - You can enter a caption for your table. If you do enter a caption it will appear directly

above the table you have inserted.

Cell Padding - You can set the distance (number of pixels) between the edge of the cells and the

text in the cells.

Cell Spacing - You can set the distance (number of pixels) between each cell.

Border - You can set the width of the border (number of pixels) for the table. If the border is set to

a number other than 0 the border will appear for every cell in the table. If the border is set to 0,

no border will be visible on the page. This is very useful if you are using the table to format and

place text and images on the page. You can view the invisible borders for editing purposes by

clicking on the View Invisible Borders button (see below). 

• View Invisible Borders - If you have set the borders of a table to 0, you can view the borders for

editing purposes only by clicking on this button. Clicking the button a second time will hide the

borders again. Please Note: Using this feature does not make your borders visible on your web

page, it is for the purposes of editing the page only. This button will not work on tables that have

visible borders.

• Insert Row - You can insert a row into a table by placing the cursor into the table where you

would like the new row inserted and then clicking on this button.

• Delete Row - Delete a row of a table by placing the cursor in the row you wish to delete and

then clicking this button.

• Insert Column - Insert a column into the table by placing the cursor where you wish to insert the

column and press this button.

• Delete Column - Delete a column of the table by placing the cursor in the row you wish to delete

and then clicking this button.

• Insert Cell - You can insert a single cell into a table by placing the cursor in the table where you

wish to insert the cell and then clicking this button.

• Delete Cell - Delete a single cell in a table by placing the cursor in the cell you wish to delete

and then clicking this button.

• Merge Cells - You can merge the contents of two or more cells into one cell by selecting the

content of all the cells to be merged and then clicking this button.

• Split Cell - You can split a single cell into two by placing the cursor in the cell you wish to split

and then clicking this button.

When you have entered all of the content for your page, click on the Save button at the top of the

page. This will save your page content and return you to the Build tab.
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From the Build tab you can either Preview the page you have just changed by clicking on the Preview

button to the right of the page name, or you can edit another page by clicking on the Edit button next

to the page you wish to edit.

Using the HTML Editor

If you have knowledge of HTML you can elect to enter HTML directly into your page rather than using

the Web Page Editor. This can be useful if you have some specific formatting requirements or if you

would like to paste HTML code directly into your page. You can switch between the Web Page Editor

and HTML editors by clicking on the Switch to… button at the top of the page.

Adding Images to your Website with the Image Manager

You can add and delete images and photographs to your website easily using the Image Manager. Before you

can start though, you must have the images stored on your computer in either a .gif or a .jpg format. These

are the only image formats that the Melbourne IT WebWorks interface will support. As a general rule, it is best

to always ensure that the file size and dimensions of your images are not too large. A maximum file size of

30Kb and a dimension no larger than 400 x 400 pixels are recommended.

If your images are stored on your computer in the correct format, click on the Build tab. Select the Image

Manager by clicking on the Continue button in the Image Manager box.

Before including images in your website, you must transfer them from your computer to your website. You do

this by clicking on the Browse button and locating the image file on your computer. When you have located

the image, select it and click the Open button. The location of your image file will appear in the filed on the

page. Click the Continue button ONCE ONLY. Depending on the size of the image you are transferring, it

may take several seconds for the page to change. When the image has been transferred you will see a

message confirming the successful transfer. You can continue to transfer more images if you wish.

The images are now on your website ready to include in your pages. To add an image to your page, edit the

page as normal (see above) and insert the image using the Insert Image button on the toolbar.
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Publishing Your Website

Whenever you make a change to your website, by either updating page content or adding or removing pages,

you must Publish your website again.  When you Publish your website, all the changes you have made become

visible on the internet.  Your changes will not take effect on your website until you Publish it.

Click on the Publish tab.  You have the option to either Preview Website or Publish Website.  You may Preview

your website to see how it will look after you have published it.  It is a good idea to do this as it provides you

with one last chance to check your content before the rest of the world can see it.  If you are happy with your

content, close the new browser window and click on the Publish Website button. Your pages will be recreated

with the new content.  You will see a confirmation message indicating that the Publication has been successful.

You can go directly to your website by clicking on the View Website button.  

NB: If you have visited your website since you last turned your computer on, the pages are likely to be cached in your
computer’s memory.  This means that when you visit your website again your computer will retrieve the page from its
memory instead of going back to the server and looking up the page again.  Therefore your computer will display the old
page instead of the new one.  To overcome this click the Refresh button on your Internet Explorer tool bar.  Your latest
changes should now appear.  Each time you turn your computer off the cache is cleared.

Promoting your Website on the Web

Google Submission
The Continue button is a link to the Google search engine submission page.

Website Statistics

Traffic

Traffic Summary

Month/Day/Week/Hour

Page Views

Rush Hours

Last 7/30 days

These reports allow you to track visitors to your website.  It allows you to see what times of the

day are most popular and what day you attracted the most visitors.  It is displayed in a

combination of charts and graphs for both numerical and visual comparisons.

Systems

Most Popular

Operating Systems

Browsers

Screen Resolutions

Java Script

Colour Depth

This group of reports allows you to see what systems your website visitors are using to view your

website.  It can be used to determine what colours, sizes and coding are most appropriate for

the majority of your visitors to view your website optimally.  
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Referrers

Referring domains

Top 100 referring URLs

Major Domains and Countries

If you have submitted your website to search engines or linked your website to another one, this

report will allow you to see what has been the most effective.  It also allows you to see where in

the world people are viewing your website from.

Visitors

Last 100 visitors

New Visitors

Return Visitors

These reports show visitor’s host names and IP addresses.  It allows you to see if any other

companies have viewed your website, or if it  is mostly dial up users.  It also shows how many

new visitors you have attracted during the month and how many people are returning to your

website to have another look around.

Pages

Most Requested Pages

Entry Pages

Exit Pages

Single Access Pages

Pages viewed per session

Time spent per session
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Managing E-mail Accounts

A Melbourne IT WebWorks solution provides you with up to 5 POP3 e-mail addresses on your domain name.

From the E-mail Management page you can add, delete or change the password on an e-mail address.

Add an E-mail Address 

Click on the E-mail tab. Then click on the Add Account button. Enter the details for the new account,

the Account Name (i.e. jsmith is the user name in the address jsmith@yourdomain.com.au) and then

enter the Password. You will need to enter the password a second time in the field below the password

field to confirm that the password is correct. Then just click on the Save button at the bottom of the

page and your new e-mail address is set up.

Delete an E-mail Address

Click on the Email tab. You will see a list of the e-mail addresses you currently have set up on your

domain. To delete one of those accounts simply click on the Delete button to the right of the account

you want to delete.

Change an E-mail Password

Click on the Email tab. You will see a list of the e-mail addresses you currently have set up on your

domain. To change a password, click on the Password button to the right of the e-mail address you

want to change the password on. This will take you to the Change E-mail Account Password page.

Simply enter your new password in each of the fields on this page and then click on the Save button.

Setting Up Your E-mail Software

One of the important features of the Melbourne IT WebWorks interface is the facility to set up and

control e-mail addresses using your Melbourne IT WebWorks software. Once you have created your e-

mail addresses you will need to setup an e-mail program to collect your mail.

There are many e-mail programs available these days, but the most popular are Microsoft Outlook and

Outlook Express, and the Eudora e-mail programs. 

The instructions below are the setup instructions for Outlook Express, this is the free and very powerful

e-mail program that comes with Microsoft Internet Explorer. 

For each e-mail address that you want to collect mail from, you will need to set up an “Account” in

Outlook Express and configure that account to connect to your e-mail box.

The steps to do this are as follows:

Create an account

Open Outlook Express and go to Tools on the menu bar and then select Accounts. A pop up

screen will open, select the mail tab at the top and then click on the Add button and select

Mail. This will start the “Add account wizard” that will step you through the creation of your new

e-mail account.

On the first screen of the wizard, enter the name that you would like to appear on all your e-

mails as the sender, that may be either your personal name or your company name. Click Next
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The next screen gives you the option of whether to use an existing account or create a new

account. As you have already created an account using your Melbourne IT WebWorks software

you should select the option “I already have an e-mail address that I’d like to use” Click Next.

At the top of the next screen is a drop down field and the default value is POP3. Leave this as

POP3. The next field down requires the location of the mail server for your incoming mail. The

setting for this is:

mail.yourdomain.com.au

The next field on this screen is the mail server setting for your outgoing mail. The setting for this

is also

mail.yourdomain.com.au

Click Next

The next screen is where you enter your own e-mail account name and password. The account

name will be your full e-mail address (ex. joe@yourdomain.com.au). Place this account name

in the Account Name field. Then enter the password you used when you setup your e-mail

account in the Melbourne IT WebWorks admin module. (There is a tick box below this field

titled “Logon using Secure Password authentication”, ensure that this is NOT TICKED) Click

Next

You have reached the end of the process, click Finish

You will now need to go back into your account by clicking on tools, account.  Pick the account

you just created and click on properties.  Click on the servers tab at the top of the page and

down at the bottom where it says Outgoing Mail Server check the box that is beside “My server

requires authentication”.  Click on OK.

Your e-mail account has now been created.

Collecting Mail

If you connect to the Internet manually by double clicking a dial-up connection shortcut on your

desktop or any other way, collecting your mail can be accomplished simply by opening Outlook

Express and clicking on the Send & Receive button on the toolbar.

If you want Outlook Express to dial automatically to connect to the Internet and collect your

mail, you will need to specify your dial-up connection.

To set this Select Tools>Accounts from the Menu bar, and then in the pop up screen that

appears, click on the Properties button. This will open a new screen which details all the

properties of the account you selected.

Click on the tab “Connection” and you will see a check box titled “Always connect to this

account using”, click in this check box.

The next step is to select the Internet dial-up connection to use from the field below, if you click

on the down arrow to the right of the field it will show you the Internet dial-up connections you

already have setup on your PC. Select the connection you wish to use to dial-up for your e-mail

account and then click OK. You will be returned to the Accounts list, close this screen as well.
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Every time you click on Send & Receive in future Outlook Express will automatically dial into the

Internet using the connection you have specified, and then check your mail and send any new

mail.

Changing Settings on your Account

You may change any of the settings for your account at any time by using the Administration pages. You can

change your company details, company logo, website style template, Menu Manager settings and user details

and password.

Changing Company Details

Click on the Admin tab. Select the Company Information option on the page. You may update any of

the information on the page. Your Company Name and Slogan will appear on your website, so ensure

that they are correct! The e-mail address is used for all correspondence from your website, so be sure

to use a valid e-mail address that is checked regularly.

Changing the Website Style

Click on the Admin tab. Select the Website Style option on the page. You can select a template style

and a color scheme from the list of templates. A preview of the website styles will appear on the page.

You can see a larger preview by clicking on the Zoom button. You must select both a template and a

colour scheme for your selection to be valid. When you have selected a Website Style, click on the Save

Button.

Changing the Company Logo

Click on the Admin tab. Select Company Logo from the options on the page. You must have an image

file for the company logo stored on your computer in a valid image format (.jpg, .gif). Click on the

Browse button and locate the logo image file on your computer. When you have located the image,

select it and click the Open button. The location of your logo image file will appear in the field on the

page. Click the Continue button ONCE ONLY. Depending on the size of the image you are

transferring, it may take several seconds for the page to change. When the image has been transferred

you will see a message confirming the successful transfer. 

Changing the Menu Manager Settings

Click on the Admin tab. Select the Menu Manager from the options on the page. The current Menu

Manager Settings will be displayed. If you change any of your master settings, the page menu and

page names on your website will change. You may set your menu buttons by either typing directly into

the fields or by selecting from the sample list provided. If you place a menu button name in the Reply

Form field, the reply form will be included on your website.

When you have completed changing your Menu Manager Settings, click on the Save button.

Editing User Details

You may change your user password and contact e-mail address at any time. Click on the Admin tab.

Select Edit User Details from the options on the page. If you wish to change your user password you
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must enter it twice to confirm. When you have completed making your changes, click on the Save

button.

Using Reply Forms

A Melbourne IT WebWorks solution allows you to get feedback and inquiries from your website by using the

built in Reply Form. You can activate the reply form on your website by providing a menu button reference for

the reply form in the Menu Manager Settings. The reply form is a standard format so it is not editable.

When you activate the Reply Form feature on your website, you will notice that a Thank You page appears in

your list of pages. The Thank You page is the page that your visitors will be directed to after they have

completed your reply form and submitted the information to you. You can use the Thank You page to thank

your visitors for providing feedback or for making an enquiry.

All input from Reply Forms on your website are e-mailed to the e-mail address provided in the Company

Settings of your website. It is important to ensure that the e-mail address you enter in the Company Settings is a

valid address.
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Advanced Users Manual

Content Tips

No one said putting together a web page would be easy, even with a great tool like Melbourne IT WebWorks.

Coming up with the content for your pages can be time consuming and tricky – so we thought we would take

some of the mystery out with the following tips:

When designing a web page keep the following information in mind:

• keep the layout simple and consistent across all related pages

• keep content clear and concise, don’t use too many words when fewer will do – 100 words is a lot in web

terms

• organise pages so readers can quickly scan for the information they are looking for

• group related information together (using headings and rules)

• pay attention to your spelling and grammar, so that your business is portrayed professionally

• Get somebody to proof read your website after you have made changes  

• use images that are relevant to the content and keep images to a minimum to ensure fast download

speeds for your visitors with slow connections

When designing your page be sure to avoid:

• overusing text emphasis (bold, italics, all capitals)

• underlining text, this generally should be reserved for hyperlinks only

• using blinking or glowing text for emphasis

• cluttering a page with unnecessary images

• linking to irrelevant pages

• using a technology for its own sake, make sure it has an application

Remember that:

• the first page is the most important page

• a web page is fundamentally different than a printed page

• it is important to keep your content up to date

Tables

Note : The Melbourne IT WebWorks Web Page Editor includes a table feature so some of the information

provided below is no longer required to insert a table into your page. The following information has been

provided for users who wish to learn more about manually editing table using the HTML editor.

Tables are extremely important in content layout.  It allows you all the freedom you need in how you are going

to lay out your content.  The following information will take you through how to set up a table, resize a table,

insert a picture, and add background colours to your table.

Creating a Table

The easiest way to create a table is to do it in Microsoft Word.  If you open Word, click on table, click on insert

table – you can then choose how many rows and columns you would like.  You can insert any of the text for
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your table ahead of time, but be sure not to insert your pictures while you are still in Word.  You then need to

copy and paste your table from Word into the Melbourne IT WebWorks Web Page Editor.  

You can resize your table while in here by simply clicking on the table and grabbing the handles to

drag in or out.  

To make the borders invisible at this point you will need to go into the HTML.  In amongst the coding,

you will need to look for <TABLE border = 1>.  If you change the 1 to a 0 and go back into the

Webpage Editor you will notice your borders are now invisible.  You can use this procedure in reverse

to make the borders visible as well.

Adding Text

Text can be added in either Word or once you have brought your table into the Melbourne IT

WebWorks’s Web Page Editor.  Simply type any text needed into the cells.  Please note, you can resize

individual cells using Word, but you can only resize the whole table in the Webpage Editor.  You can

align your text to the left, centre, or right of the cell by using the text align buttons.

Adding Images

You must add all images to the table after you copy it into the Webpage Editor.  Simply put your cursor

in the cell that you would like to insert an image into, and then click on the “Insert Image” icon.  Pick

the image you would like to insert, leaving the alignment setting at default.  The cell will automatically

resize to fit the image.

Adding Background Colours to a Table

Adding background colour is a bit more advanced, but does tend to give your website a nice look.

Adding colour to your table is possible in Word, but there is a relatively small selection of colours to

choose from.  To do it this way you highlight the cells you would like to add background colour to,

click on “Format” and then click on “Borders and Shading”.  Click on the “Shading” tab and select the

colour you would like to display in your cells.

The other way to do this involves going into the HTML.  The first thing you will have to do is find out the

colour code of the shade or colour you would like to use.  There are a few ways to do this.  If you are

using a colour from an image that you have, you will need to bring that image into an image editor on

your computer.  Use the eyedropper tool and click on the colour you would like to use.  By doing this

you will find it has taken that colour and put it in your palette.  By double clicking on your palette you

should be given the colour code. (Example white = #FFFFFF)  You will need to write that code down

so you can use it later to add the background colour.  

Now you need to go back to your Webpage Editor and click on the HTML tab.  To put a background

colour behind a whole table you will need to find “<table border=0>”. Just behind the word “table”

you will type in “bgcolor=#FFFFFF” (replace the FFFFFF with your colour code).  If you want to put the

background colour only in a certain cell you will need to find the <TD> tag in front of the text in the

cell you would like the colour in.  Using the same coding you will insert it into the <TD> bracket so it
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looks like this <TD bgcolor=#FFFFFF>.  If you click back into your Webpage Editor now you should

find that your table or specific cell now has a background colour.

Make sure if you are using background colours behind text that it is still easy to read the text.  You may

find you have to change your text colour to make it easier for your visitors to read your information.

Thumbnails

Thumbnails are small pictures on your website, which link through to a larger picture of the same image.

These are used extensively on the web and many of our customers have them set up on their websites. 

To add a new thumbnail to your website you will need to load up two pictures of the same image to your

image manager.  (make sure the image names are slightly different ex. adding S for small or L for large at the

end of the file name) One of the images will be quite small (normally around 100 to 150 pixels) and the other

one will be large enough to fill a screen (normally around 600pixels wide and 500 pixels tall).  

Now that you have loaded the image into image manager you need to go into the edit section of the page on

which you would like to have the thumbnail.  Align your cursor to where you would like to insert the picture and

click on the “insert image” icon.  Choose the small image to insert on to your page.

Now you need to hyper-link the small picture to the large picture.  The first step is to find out what the address

of the large image is.  Click on the “insert image” icon again and click on the large image.  You will notice in

the URL box below is the address of the image.  Highlight the address, right click and click on copy.  You can

now close the insert image box.

The next step is to create the hyperlink.  Click on the small image you have inserted on to your page and then

click on the “hyperlink” icon.  Click on the Other Links tab at the top and on the pull down menu use “Other”.

Now right click in the empty field below and click on Paste.  Click on OK and your thumbnail is complete.

If you would like your thumbnail to open in a new window you will need to go into the HTML after you have

created the thumbnail.  Your thumbnail will look like this in the HTML coding

<A href="http://designer.Melbourne ITwebworks.com.au/images/imagelarge.jpg”>

<IMG border=0 src="http://designer.Melbourne ITwebworks.com.au/images/imagesmall.jpg">

To have it open in a new window you will need to add the highlight part in to the coding.

<A href="http://designer.Melbourne ITwebworks.com.au/images/imagelarge.jpg" target=_blank>

<IMG border=0 src="http://designer.Melbourne ITwebworks.com.au/images/imagesmall.jpg">

Adding Anchors to WebPages

Definition: An anchor is a marker inside a web page that when linked to, takes the user straight to that part of

the page. It is particularly useful for long pages with different sections.
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To add an anchor to your page, there is a 2-step process: creating the anchor and creating the link.

1) Creating the anchor

- Open Notepad on your PC

- Type the following to create all your anchors:

<a name="Heading1">Heading1</a>

<a name="Heading2">Heading2</a>

... and so on. Each line should have the name of the section you wish to link to.

- Now, save the document as links.html

- Close Notepad and open Internet Explorer

- File -> Open - choose links.html

- You'll now see a list of the links you've made looking something like this:

Heading1

Heading2

- You now need to copy each heading into your web page using the Web Page Editor. You can change the

font, size and colour of the heading once it's in there.

2) Creating the link

- Create a link that goes to the page you've just made headings for.

- Then right-click the link ands choose 'edit hyperlink'
- Straight after the link add #Example1.

Scanning and Resizing Images

Scanning Photos

Everyone’s scanner has different properties, so you will need to learn generally how to use your

scanner.  As for what size, resolution, file type to create – the best ways to do this for content to go on

your website is listed below.

Scan your image in at about 150 dpi as this will allow you to edit the image later without any loss of

quality.  

Make sure you are scanning in at 24 bit colour.

Save your picture as a “high” quality jpeg to give you a good quality image to work with.  Make sure

your scanner is clean and the picture you are scanning from is of good quality.  There can be problems

scanning from computer printed images as the quality tends to be poor.

Resizing and Editing Pictures
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Once you have finished scanning you picture you will now need to do any editing necessary.  Most

scanners come with software, which will allow you to edit your images.  You can adjust brightness, and

contrast to improve your image.  You will also need to do all image resizing at this point.  

Open up your image that you have scanned into your image editor.  To resize a picture you will likely

find the function to do this under the “Image” menu or the “Edit” menu.  It is usually called “Resize” or

“Resample”  By adjusting the number of pixels, or inches you can adjust the size of your image.  It is

important to ensure you are viewing your picture at 100% to get a true representation of how large

your image is.  

Trouble Shooting – Common Questions

Question: When I hit the Enter key in the Web Page Editor I get a double line space instead of a single one.

Solution: Hold the Shift key when you press Enter and you will get a single line space

Question: I have made changes to my website but when I view it I cannot see them.

Solution: Each time you make a change to your website you need to Publish it again to make the changes

effective (see page 13).  If you have already published your changes and they are still not visible click on the

Refresh button on your Internet Explorer tool bar this should make the changes visible (see Page 13 for details

regarding this).
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